Decision Explorer Workbook 1

By Jennifer R Brightman, Banxia® Software Ltd

Version 1.1, Published October 1998

OVERVIEW........................................................................................................... 2

The software ........................................................................................................ 2
The tutorial ........................................................................................................... 2
Getting started .................................................................................................. 3
Requirements ..................................................................................................... 3

STAGE 1 - BASIC DATA ENTRY ........................................................................... 3

The opening screen .......................................................................................... 3
Entering a concept using the mouse ............................................................... 4
Editing a concept ............................................................................................. 4
Entering a concept using the command line ................................................. 6
Linking between concepts ............................................................................. 8
Adding more detail to the model ................................................................. 8
Representing a line of argument .................................................................. 9
Moving concepts around the display area and display scale .................... 9
Practising entering and linking concepts .................................................. 11

STAGE 2 - IDENTIFYING CATEGORIES OF INFORMATION IN THE MODEL ...... 12

Display styles ................................................................................................. 12
User defined sets ............................................................................................ 14

STAGE 3 - SIMPLE ANALYSIS .......................................................................... 16

Tidying up a model .......................................................................................... 16
Groups of concepts (clustering) ................................................................. 17
Complexity of linking .................................................................................... 18
Analysing a hierarchical model ................................................................. 19

HINTS AND TIPS ............................................................................................... 20

Changing the substance of a model or changing the contents of a view .. 20
Display scales .............................................................................................. 21
Refreshing the map display ......................................................................... 21
Link types ...................................................................................................... 22
The difference between the map and the bring commands .................... 22

CONCLUDING REMARKS ............................................................................... 22

THINGS TO REMEMBER ... ............................................................................ 23

FEEDBACK PLEASE .......................................................................................... 23

Decision Explorer is developed and published by Banxia Software Ltd and distributed world-wide by Scolari, Sage Publications Software. Full information and a working demonstration are available at http://www.banxia.com, or call Scolari on (UK +44) 0 171 330 1222 or (USA +1) 805 499 1325.
Overview

This is a step-by-step tutorial to introduce you to Banxia’s Decision Explorer.

By spending an hour or so working through the core parts of this tutorial you will get to grips with the basics of data entry, model structuring, and analysis. You will also start to see more ways in which Decision Explorer can help you to explore the different ideas and perspectives surrounding an issue. By using Decision Explorer you will see how ideas fit together and, in so doing, inform your thinking.

The software

Decision Explorer is a tool that has been designed to help you to see relationships between different ideas and perspectives which might be expressed about any subject. In Decision Explorer the unit of data entry is a “concept”. A concept is a short phrase, which captures the essence of an idea, it is part of a chain of argument. Concepts are linked to express the logic of an argument or lines of reasoning. As each concept is entered it is given a unique reference number automatically by the software.

By building a visual representation of the ideas and perspectives surrounding an issue, Decision Explorer provides a focus for debate and reflection. It helps to clarify thinking. You can use it to map your own thoughts, ideas that you have gathered from interviews, or ideas that are generated during a group discussion. The principle is that you work with the ideas, see how they fit together and how they influence one another and by doing this generate new ideas. Working through this process acts as an effective stimulus to help you to identify and focus on important issues.

When discussing an issue ideas are broken down into their constituent parts and then reconnected to show the lines of reasoning. Ideas are presented in graphical format as a network of short phrases connected by links. The short phrases (referred to as concepts) capture the essence of the ideas and the links show the relationships between ideas. Links are usually read as “may lead to”, “supports” or “causes”, but there are options for using other link types, to which you can ascribe different meaning (alternative link types are described in more detail in the User’s Guide).

The tutorial

As you go through this tutorial you will be asked to perform various tasks and an explanation will be given of what you have done and why. By the end of the tutorial you should be able to build a model of your own and carry out some basic analysis. Having completed the tutorial the best thing to do is to start to put what you have learnt into action and work with a situation that is real to you – in doing this you should start to see some of the benefits of using Decision Explorer. You might want to think about the future of your business, or what you are trying to achieve with a project that you are involved with, or perhaps something else that is personal to you. Almost any situation where you want to explore the interrelationship between the different influences involved.
To help you to work your way through the tutorial the following system for displaying information has been used:

- **Core exercises are shown in activity boxes using this style (with shadow)**
- **Optional exercises are shown in activity boxes using this style (without shadow)**
- **Important points to note are shown in notes boxes using this style**

Background information is shown with a shadow behind the text. You may not want to read all of the background information but reading it will give you a better understanding.

**Getting started**

Before starting the tutorial you should be familiar with the Microsoft Windows® environment. If you do not have the full version of Decision Explorer, install the Decision Explorer demonstration software on your PC. Insert the disk into the appropriate drive and run the SETUP.EXE program. The version of Microsoft Windows that you are using will determine whether or not you run the install program from the Start Menu, Run item or the File menu, Run item.

**Requirements**

To install and run the Decision Explorer program your PC should have a minimum of 4MB of RAM, 2MB of hard disk space and should be running Microsoft Windows 3.1 or later (e.g. Windows 95, 98 and Windows NT).

Decision Explorer is known to install and run on Apple Macintosh machines if you have a Windows Emulator available.

**Stage 1 - Basic data entry**

**The opening screen**

When you have loaded the program and you run it for the first time, you will be faced with white mapping area, overlaid by a small “tip of the day” dialog. These tips can be accessed at any time via the Help menu, Tip of the day item. They give you useful hints and tips about the use of the software.

**Action:** (closing Tip of the day dialog)

1. Close the Tip of the day dialog by clicking on the OK button.

You should now be faced with a blank area, which is essentially a blank piece of paper (the different sheets that you can work on), with view tabs along the bottom of the screen and button bars and menu items along the top of the screen.
Action: (checking model status)

1. Check that at the top of the window the model name appears as “Untitled”. If not, go to the File menu and select the New model item.

2. Look at the view tabs along the bottom of the screen, check that you are in view1. The view tab for the view that you are working in is highlighted. If you are not in view1, move the mouse pointer to the view1 tab and click with the left mouse button.

Note: the default for a new model is to open in view 1 and map display mode.

For many operations in Decision Explorer there is more than one way of achieving the same result. Initially you are likely to find that you use the mouse and the menus for most operations, but as you become more familiar with the program you will find that the command line and short cut keys make for faster and more seamless operation.

Entering a concept using the mouse

Action: (entering a concept on the map display)

1. Place the mouse pointer anywhere in the mapping area and double click. The pointer will change to an “I-beam”, a number will appear on the screen with a flashing cursor to the right of it. The number is the concept reference number, which is automatically generated by Decision Explorer.

2. Omitting the quotation marks, type the short phrase “long queues at X-ray”. The text will appear on the screen.

3. When you have finished typing, press enter.

You have just entered a concept which should now look like this:

1 long queues at X-ray

The situation here is one that you might be familiar with. We are thinking about the circumstance where somebody is checking in for a flight and they are dissatisfied with the situation because they are faced with long queues at the X-ray machines. The question now is what would they prefer instead? This brings out the contrast or opposite pole of the idea. Our passenger says that he would prefer to wait for 3 minutes or less at the X-ray.

Editing a concept

You have entered the first part of the concept (the emergent phrase) and now you need to edit it to add the contrast. There are various ways of doing this but the fastest way is to select the concept to be edited and to double click on it. The mouse pointer will change to an I-beam and the flashing cursor will appear at the start of the concept text.
**Action:** (editing a concept)

1. Move the mouse pointer over the text of the concept that you want to edit.
2. While keeping the pointer over the text, double click the left mouse button. The pointer will change to an I-beam and the flashing cursor will appear at the start of the text.
3. Edit the text to read “long queues at X-ray, 3 minutes or less at X-ray”. You can move to the end of the existing text either by pressing the End button twice or by using the cursor keys. Note that you should type a single period (a dot “.”), between the two parts of the concept (and, again, omitting the quotation marks for the text that you are entering).
4. When you have finished editing the text either press \[ \text{Enter} \] or click the mouse pointer anywhere in the mapping area away from the concept which you have been editing.

You now have a concept which reads:

1 long queues at X-ray … 3 minutes or less at X-ray

The three dots (known as an ellipsis), which automatically replace your single dot in displays, are a short hand for “rather than”, so the full concept is read as “long queues at the X-ray rather than 3 minutes or less”.

When you are building a model you do not have to have a contrasting pole in every concept but it is important to watch out for them and to enter them, where they exist, as a single concept rather than two separate concepts. If you enter them as separate concepts you will end up with a model which is much more “bitty” than it needs to be and it will more difficult to read. The emergent phrase or emergent pole is that which is expressed or elicited first, the contrasting or opposite pole follows.

You can, of course enter both poles when creating a concept. Entering the whole concept here in two actions (first one pole – the emergent phrase, and then the other – the contrasting phrase), was done to show you how to edit a concept.

Contrasting poles are important, giving more meaning to ideas, and bringing out the “shades of grey” in peoples’ thinking. If the situation is one where the contrast is of a “yes/no” type then you may well not need to add it. In fact, you can ask the software to show you this type of “not” contrast automatically. But where the contrast is important and not so clear cut it should be explored and added to the model. Opposite poles (contrasts) show how meaning changes, for example the first two concepts here were drawn from a discussion with two people about their use of mapping:

- mapping helps you explore ideas … wasting time with lots of pieces of paper
- mapping helps you explore ideas … just making a snap decision.
Or, from a discussion on leadership:

<table>
<thead>
<tr>
<th>charismatic leader … boring leader</th>
</tr>
</thead>
</table>

and

| charismatic leader … dictatorial leader |

Now we need to start exploring other thoughts surrounding this situation. When you are building a causal model the simplest way to describe how models are elaborated is to say that you should consider asking “how” and “why” questions. For example to move up a line of argument and elicit the consequences of a particular concept, you ask questions like “why is this important to me?” “Why do I want to achieve this?” To move down the model or explore the explanation beneath a particular concept you ask “how” questions such as “how would this be achieved?” “How was that caused?” The exact phraseology of the questions will vary but what you are trying to find out is where something might lead (So what? Or why?). And, what might have made it, or might make it, happen in the first place (How?). This is called “laddering” and the structure that you are building up is one of:

```
Why
How
End
Means
Outcome
Action
```

This sort of mapping helps to draw out the most important ideas, and you may discover that what you thought you were aiming for is really just part of a higher goal. As you repeat this for each concept you may also find that the real issue is focused elsewhere. It also encourages you to fill in the detail and the explanation lower down the model, by thinking about what might cause or what might have caused something to happen.

In this example case our angry passenger is asked why the long queues are problematic for him. In reply he says that it creates a high level of anxiety in him about missing his flight rather than the X-ray being a welcome, routine check. So we can enter a second concept:

```
high level of anxiety about missing flight … welcome routine check
```

**Entering a concept using the command line**

The command line gives you faster, seamless operation. Becoming proficient in the use of the command line does involve a little more learning but you will find it worthwhile. You could enter the second concept as we did the first, by double clicking with the mouse on the mapping area, but this time we will use the command line. The command line gives you access to all the power of Decision Explorer and also means that if you are using Decision Explorer in a group setting you do not obscure the map display area when you are entering
concepts or issuing commands. The drop-down menus are distracting in a group situation and reduce the speed of operations.

Note: the command line appears automatically along the bottom of the window when you type any of the alphabetical or numeric characters on the keyboard. To cancel the use of the command line, press the \[ESC\] key.

We are now going to use the command line to enter the next concept. To tell the software that you are entering a concept rather than issuing another form of command you must enter an “=” (equals) sign at the start of the text. The concept text appears along the bottom of the mapping area (above the view tabs).

Action: (entering a concept using the command line)
1. Type the following on the command line (it will appear when you start typing):
   
   = high level of anxiety about missing flight.welcome routine check

   Do not forget to put a single period between the words “flight” and “welcome”. When you press return and enter the concept in to the model the period will automatically be converted to three dots (“…”), the shorthand for “rather than”, you do not have to do this yourself.

2. When you have finished typing, press the \[Enter\] key. The concept that you have entered will appear on the screen.

Note: You need only read this section if the concept that you have just entered does not appear on the screen. While you are unfamiliar with the workings of Decision Explorer the instructions below just give you a quick way of checking that you are doing things correctly.

If the concept that you have just entered does not appear on the screen check that it exists in the model by selecting the List menu, All concepts item. This asks Decision Explorer to list all of the concepts in the model. A list of concepts will be displayed in the text display of view1.

If the concept does not appear in the listing then the fastest way to bring it into view is to change the map display scale. Return to the map display view (as described above) and then follow the instructions for changing the display scale as described on page 9. If you do not want to change the display scale then you can use the scroll bars that appear along the bottom and right hand side of the map display area.

Optional activity. (Experiments using the command line.)

Action:
1. Type any single letter of the alphabet or a number key. Look at the bottom of the map display area, just above the view tabs and horizontal scroll bar. You will see the command line. Any of the alphabetic or numeric keys will activate the command line.

2. Cancel the command line display by pressing the \[ESC\] key.
Note: If you find that the menus are not active or you cannot carry out an operation check to see if the command line is visible. You may have pressed a key by accident. If you have accidentally activated the command line or half issued a command and then tried to move to another operation, you will find that you cannot, and you must press the Esc key to clear any existing commands.

Linking between concepts

We have now entered our first two concepts and we want to attach further meaning to them by entering a link between them. We will link concept 1 to concept 2.

Action: (linking concepts)

1. Select concept 1 by moving the mouse pointer over its text area and clicking and holding down the left mouse button once. The select box will appear around the concept.
2. Keep the left mouse button pressed and move the pointer away from concept 1. As you do this, the mouse pointer will change to a question mark and a line will follow.
3. Move the pointer onto the text area of concept 2. A dotted box will appear around concept 2 (the target concept).
4. To make the link, release the left mouse button while the mouse pointer is still over the target concept’s text.
5. The link property dialog box will appear. For now, just click OK and a causal link will be drawn between concepts 1 and 2. We will discuss the other link options later. Full details are in the Reference Manual and online help.

The link indicates that the queue (at the tail of the arrow) has implications for (or may lead to) anxiety about missing the flight (at the head of the arrow). An alternative expression of this relationship would be that the anxiety (expressed at the head of the arrow) is explained by having to queue. So we have a system of explanations (tails) and consequences (heads).

Adding more detail to the model

This is the start of our map. We now need to go further and add more detail. We do this by asking questions such as: “Are there other implications of the queue at the X-ray?” “Why does this matter to you?” “Why might this be important to other people?” Asking “why” type questions takes us “up” from a concept giving us consequences, while asking “how” type questions takes us “down” from a concept giving us explanations of how something might come about, or what might cause/have caused a particular phenomenon.
Asking a “why” question got the following answer:

“Well, passengers could miss their flights or the flight could be delayed by late passengers rather than the gate closing on time. We would arrive at our destination late. And I think that there would be an increase in everyone’s total journey time, if they all had to allow an extra 30 minutes to get through the X-ray machines. We couldn’t spend time in the shopping mall either, or at least it would be reduced anyway. My wife likes to spend time in the shopping mall, even if I’d rather she didn’t! There are loads of things that this could affect.”

Now let us think about what is causing the long queues at the X-ray in the first place: how did they come about? This is likely to bring out possible solutions as well. Our passenger said:

“When I complained they just said that they didn’t have any more staff – if they had they could operate more X-ray machines. But you can see how crowded it is in here, they would need to rearrange the whole place to get more machines in.”

**Representing a line of argument**

The last part of the conversation above, about how the queues came about, would be mapped as shown in the picture.

The argument was not presented in this format and you will quite often find that people present their arguments in a disjointed manner. Here our passenger sees having more staff and more X-ray machines as a possible solution to the problem. However the room must be rearranged. So clearing or finding more space for X-ray machines, may lead to being able to have more machines available, which may lead to deploying more staff (rather than not having more staff, or in our passenger’s words “haven’t got the staff”) so more machines are working and the wait is reduced to 3 minutes or less. As you will see Decision Explorer makes it easy to edit and change your model, so if it is not quite right first time, there is no problem.

**Note:** there is a negative link between “deploy more staff…haven’t got the staff” and “long queues at X-ray…3 minutes or less at X-ray”. A negative link indicates that the emergent phrase (that is the first part of the concept) leads to the contrasting phrase in the concept and visa versa. So that “haven’t got the staff” may lead to “long queues at X-ray”, and “deploy more staff” may lead to “3 minutes or less at X-ray”.

**Moving concepts around the display area and display scale**

As you enter more concepts the display area will start to become crowded and concepts may start to overlap one another, so you need to know how to move concepts around the display area. What may also happen is that the concepts that you are entering do not apparently appear on the mapping area. They are there in the model but you are, in effect, only looking at a small section of a very large display area. You can scroll around the screen to display concepts which are just out of view, but you may find it easier to change the display scale.
**Action** (moving concepts around the screen):

1. Select the concept that you want to move by placing the mouse pointer over the concept text and clicking once with the left mouse button. The select box will appear around the concept.

2. **Keep the left mouse button pressed down** and then press the right mouse button. When both the left then right mouse buttons are pressed simultaneously the mouse pointer will change to a hand and you can now “slide” the concept around the display area and move it to the desired position.

3. Release both mouse buttons to “drop” the concept at the new location. This is a quick way to move concepts around the screen. You can also achieve this using the right-click popup menu (see User’s Guide or online help).

**Action** (changing the display scale):

1. Go to the View menu, Display scale item (it is about halfway down the menu). There are four sub-options – normal size, half size, fit to window and select zoom. When Decision Explorer creates a new model, as you have just done, the default view scale is normal size. You can still see everything that you have entered by using the scroll bars at the right hand side and the bottom of the display area. But, you may find it more convenient to work in fit to window mode.

2. Select fit to window. As your map grows in size, the concepts will shrink, as they are all fitted in to the available display space. When the concept text becomes too small to read the text of selected concepts will be displayed along the bottom of the window. (Please see the User’s Guide or online help for a full description of this option).

For the rest of this tutorial, work in fit to window mode.
**Practising entering and linking concepts**

Optional activity:

If you do not want to complete this part of the tutorial move to “Stage 2” on page 12.

Our passenger has exhausted his immediate thoughts on how the queuing situation affects him. So we will extend the questioning and think about the wider implications of the situation. In the text below, the concepts extracted from this discussion are shown between the “/” marks. Enter the concepts and put in links, where your logic dictates. Think in terms of “leads to”, “causes” or “supports” when putting in links from one idea to the next. Our passenger goes on to say:

“Well, I guess that /passengers missing flights/ would /increase the airport reputation for inefficiency/ because if it went on all of the time, people would get to know about it. In fact I think that /passenger frustration with air travel/ is my real concern. As I said before, I remember that I complained to the supervisor and asked why they didn't /deploy more staff/. He said /'haven't got the staff/ – if I used more staff that would be an /inefficient use of staff/ because they would be /standing around half the time/.”

“Yeah, and going back to the thing about inefficiency, that could lead to a /decrease in the airport reputation for safety & security/, you know the airport would just get a bad name. My wife suggested that the /reduced revenue in shops/ could lead to /increased landing charges/ too and that might lead to /increased air fares!/ And they’re already high enough!”

“And with all these delays and /planes not flying to schedule/ it could cause /increased "stacking"/ and that /uses more fuel/ and I guess that that would cause fares to rise too. I think that it’s all related”.

A completed version of the map is given on the demonstration disk. So when you have experimented with entering these concepts you can move on to a more advanced version of the model.
Stage 2 - Identifying categories of information in the model

**Action:** (opening an existing model)

1. Go to the File menu and select the Open model item.
2. Move the mouse pointer to the required file (which in this case is Stage2.mdl) and click with the left mouse button.
3. The file name will be highlighted in the list and will appear in the File name box at the top left of the dialog box.
4. Having selected the Stage2 model, open the model by clicking OK.

The file Stage2.mdl gives you the appropriate version of the X-ray model for use in this stage of the tutorial. You should be looking at a view entitled “my thoughts”.

You will notice that the view tabs have now been renamed to reflect the contents of the views. It is important to remember that the views are not like the separate pages of a drawing package; you can show on them whatever you choose to display from the model, so you can easily overwrite the contents of a view and rename it. You do not have to copy and paste between views, you just use the appropriate commands to ask Decision Explorer to display what you want from the model. As well as being able to rename views you can also change their order (a bit like shuffling sheets of paper). You can create up to 32 views in one model. To access the views menu, right click on any of the view tabs and a pop up menu will appear with all of the available options. View functions are not covered in detail in this tutorial.

You will also notice that small dotted arrows, with numbers, appear around some of the concepts. This is the “hidden link” display, which is telling you that there are other concepts linked in to those which are currently shown. You can decide whether or not to have this display turned on for all concepts, shown only for selected concepts and with or without reference numbers. Again this function is not covered in detail in this tutorial but it is covered in the User’s Guide and Reference Manual.

**Display styles**

We are going to add more styles to the model. So far we have just entered concepts using a single display style, but you can also make use of colour and font variations to convey additional meaning about the similarities and differences between various categories of information. The model that you have just opened currently has only one display style (called ‘standard’). For example, we might want to emphasise in the display those ideas which we think of as really important using an eye-catching bright pink or red colour, with a font which is slightly larger than that used for other concepts on the display. Or you might want to highlight your goals (what you aspire to) / not goals (what you would like to avoid!) The use of colour and font variations will draw attention to these important pieces of information.

To make use of display styles you need to know first how to create styles and then how to attribute a style to the chosen concepts.
**Action:** (creating style properties)

1. Select the Property menu, Concept style properties item.
2. Click on the New style button.
3. Enter the required style name, in this case call the style “my_goal” (omitting the quotation marks) and click OK.
4. Now choose the display characteristics for this style. Click on the Font button (on the right-hand side of the dialog box).
5. Select a black, 14 point, bold, Arial font, then click OK.
6. Click OK to close the Concept style properties dialog.

A new style has been created.

You have now created the my_goal style and have set appropriate characteristics for it. The next step is to attribute the new style to the appropriate concepts. In this case we think that concepts 2 is representative of our passengers goals (they are his goals and since we are building this model for him, it is his model and to enhance his sense of ownership of the content, we will style them my_goal). So, he wants to feel that the X-ray is a welcome, routine checking procedure, rather than something that causes him anxiety.

**Important:** In this model the borders for display styles have been turned off, but if you would like to use borders in your display styles, simply check the “enable borders display” box at the bottom, left-hand corner of the concept style properties dialog.

**Action:** (attributing style properties)

1. Switch to view3, which is now called “Others too”. Do this by placing the mouse pointer over the view tab and clicking once with the left mouse button.
2. Select concept 18. Move the mouse pointer over the text area and click once with the left mouse button. The select box will appear around the concept.
3. With the mouse pointer still over the concept text release the left mouse button and click on the right mouse button. A pop up menu will appear.
4. Move to the style item and a sub-menu, listing the available styles, will appear.
5. Move the mouse pointer to the desired style (my_goal) and click on it using the left mouse button.
6. The display style will be attributed to the concept and its appearance on the screen will change to suit.
Optional activity:
For further practice go through the same process of attributing the my_goal style to concept 3.

When you have done this create another style called key_issue, with the font attributes of fuschia, Arial, 14 point, bold, text. Attribute this style to concepts 1, 5 and 12. Create another style called airport_goal, with the font attributes of black, Arial, 14 point, bold italic, text. Attribute this style to concepts 9 and 14. These are in fact negative goals or “not goals”, things that the airport authorities would not like to achieve (but they are still part of the goal structure). The map contains a mixture of the passenger and the airport goals.

Remember that what appears on the views can be “overwritten” and redrawn at any time. To show how easy it is, move to the view marked scratchpad and type the command “map 1”. Concept 1 and its surrounding context will be displayed on that view. Try “map 2” and see what happens: then try mapping concept 9 also.

User defined sets
You can see how display styles allow you to identify concepts visually as being of a particular type. As well as the visual styles for categorising information, Decision Explorer has “sets”, which allow you to tag or group concepts “invisibly”. In Decision Explorer you can, effectively, have an unlimited number of user defined sets. The limitation is imposed by your hardware capabilities, rather than by the software.

We will create a new set and attribute a number of concepts to it.

**Action:** (creating a set)

1. Using the command line enter the command “NS air_auth”. Just start typing the first letter of the command and the command line will appear automatically. The underscore is used because set names must be whole words. If you just leave a space in the name the software will not recognise the set name, it may tell you that it has created a new set but you will not be able to list its contents.

2. Press at the end of the command and you will be told that the set air_auth has been created. Click OK. We are going to put concepts which relate to the airport authority into this set.

3. Enter the command “LS” (this means List Sets) and you will see a listing of the set names in the model, including air_auth.

Issuing the LS command created a listing so your view is now in text display mode. The map display is simply “on the other side of the piece of paper”. To switch back to the map display select the View menu, Map display item.

**Action:** (switching between map display and text display in a view)

1. Having issued a command which gives you a listing, for example, the list of sets in the model, switch back to the map display. Select the View menu, Map display item. All of the views have a map display and a text display mode, the contents of which are independent of each other.

At the moment the new set does not have any contents as denoted by the “[0]” after the set description, so we now want to add some concepts to the set. Looking at the map display we decide that concepts 9 and 15 should be added to the airport authority set.
The set change operators are:

- **=** (equals), which makes the contents of the set equal to whatever you list e.g. “air_auth = L 1-10”. The set contents are now the list of concepts 1 to 10.

- **+** (plus), which adds to the contents of a set e.g. “air_auth + L 18-20”. The concepts 18, 19 and 20 have been added to the contents already in the set.

- **-** (minus), which removes the specified concepts from the set e.g. “air_auth - L 8-10”. So concepts 8, 9 and 10 have just been removed from the contents already in the set.

Although concepts can be attributed to multiple sets, they will only appear in each set once, so do not worry if you issue a command which might try to add it multiple times. When adding a concept to a set Decision Explorer, will automatically check the existing contents of the set. If the concept is already there, it will not add it again; if it is not there, then it will be added as requested.

**Note:** If you use the ‘=’ (equals) command the whole contents of the set are replaced by whatever you have made the set equal to. If you want to empty the contents of a set simply type the set name followed by equals with nothing else, so effectively you are saying that the set contents equal nothing.

**Action:** (add/remove concepts to/from sets. Listing the contents of sets).

1. Using the command line type “air_auth = L9#15”. What this is saying is that we want to add the list of concepts 9 and 15 to the set air_auth. The ‘#’ (hash) symbol is used as the separator for discontinuous listings of concepts (you can also use an ‘&’ (ampersand) but the hash may be an easier key-stroke).

2. Press and then type “L air_auth”. This will list the contents of the set air_auth. You will see that concepts 9 and 15 are listed as members of the set.

3. Now we want to add further concepts. Concepts 10, 11 and 12 look like good candidates. Again using the command line type “air_auth + L 10#11#12” and then press .

4. This time, type the command “LS” (List Sets) and press . You will see that the set air_auth now has the number 5 in brackets after it. This tells you that there are five members in this set.

5. Now type “L air_auth” and press . This will list the contents of the set air_auth. You will see that concepts 9 and 15 are still there and concepts 10, 11 and 12 have been added to the set.

6. We have now decided that concept 10 really should not be part of this grouping so we will remove it from the set. Type “air_auth – L 10” and press . Repeat steps 4 and 5 and you will see that concept 10 has been removed from the set.
**Stage 3 - Simple analysis**

**Action:** (closing a model and opening an existing model)

If you are using the demonstration version of Decision Explorer then close the Untitled model that you used in Stage1. You can only have two models open at once when using the demonstration version.

If you are using the full version of Decision Explorer then there is no need to close the Untitled model (unless you want to), so just follow steps 2 to 5. You can have four models open at once when using the full version of the software.

1. Go to the File menu, Close model item. Save the changes if you wish, otherwise just close the model.
2. Go to the File menu and select the Open model item.
3. Move the mouse pointer to the required file (which in this case is Stage3.mdl) and click with the left mouse button.
4. The file name will be highlighted in the list and will appear in the File name box at the top left of the dialog box.
5. Having selected the Stage3 model, open the model by clicking OK.

**Tidying up a model**

Finding “orphan” concepts.

When you have been building your model for some time and have entered a large number of concepts, linking some “as you go along” and leaving others for consideration later, one of the commands which is useful for checking the state of the model is the “orphan” command.

Orphans are concepts which have been entered into the model, but which are not, as yet, linked in. What you need to do is to find the orphan concepts and to decide if and where they tie in with other concepts, and then add the appropriate link(s). If they do not tie into the model as it stands then it is possible that they represent an area that you have not yet fully explored. They may be ideas which came out in the initial brainstorm that are either no longer relevant (and can now be deleted) or which have been represented elsewhere and can now be deleted or merged.

**Action:** (finding orphans, mapping concepts, bringing concepts on to the map display)

1. Using the command line type the command “orphan” and press \[Enter\]. A listing of the orphans in the model will be displayed.
2. If an orphan seems to tie in with one or more other concepts, you need to map the orphan and associated concepts and put in the appropriate links. To do this, move to the scratchpad view and type “map <concept>\”, where <concept> is the number of the orphaned concept, so type “map 28” and press \[Enter\]. (You could map all of the orphans by typing the full list of concept numbers, using the hash separator).
3. This should tie in with anticipating the increased queues. Now type “bring 27” and press \[Enter\]. This will display concept 27 on the map view where you are currently working.
   NOTE: if you typed “map 27”, instead of “bring 27” then the map display showing concept 28 would be replaced. If you do not want to replace a map display but want to add
to it, use either the “bring” command, as we are doing here, or the ‘bring unseen’ menu item.

4. We can now link the orphaned concept into the rest of the model in the normal way. Create a link from concept 28 to concept 27. Follow the same procedure for the other orphaned concept, so do the same for concept 30 as you have just done for concept 28, from step 2 and put a negative link from concept 30 to concept 29 (check the “negative” box in the link dialog).

You will find that as you work with a model you start to remember the concept reference numbers, so you may not need to map the concepts to link them. Linking can be carried out from the command line (please see the online help or Reference Manual and User’s Guide for details, look for ‘+’).

“Head” concepts and “tail” concepts

Another useful and quick check when mapping is to have a look at the heads and tails in a model. Head concepts are the outcomes at the “top” or the end of the lines of argument. Tails are the starting points or “bottom” of the lines of argument. What these concepts characterise depends on what you are mapping. If you are mapping a chain of events then the majority of the heads will tend to be “end states” or “so what” statements. While the tails will tend to be triggering events/initial causes and “drivers” of change. In a model aimed at understanding what a person is looking for or feels about a particular situation, then the heads will represent concepts which are seen as aspirational or desirable/undesirable, and the tails will characterise options which represent action possibilities, which may lead to the desirable/undesirable outcomes.

The commands LH and LT, which stand for List Heads and List Tails, are used to list the heads and tails in the model. These commands also exist in the List menu.

**Action:** (finding the “heads and tails” in a model)

1. Using the command line type “LH” and press Enter. A list of the heads in the model will be displayed.

2. Using the command line type “LT” and press Enter. A list of the tails in the model will be displayed.

Consider the contents of the listings and see if they make sense in the context of the model that you are building. Then elaborate and edit as appropriate.

**Groups of concepts (clustering)**

Looking for groups of related concepts (clusters) within a model helps you to find the focus areas or themes within a model and to check that like categories are linked with like. Decision Explorer allows you to perform a cluster analysis on all or part of the model. The cluster analysis can be initiated from the command line (typing the word “cluster” and pressing Enter) or from the Analysis menu, Cluster item. The full cluster options are provided in a dialog box, which is accessed from the Analysis menu. Please see the Reference Manual or online help for more details. In this model the cluster analysis only finds one cluster. This is not as uninformative as it might appear! The result of the cluster analysis suggests that, based on the picture of the situation as it stands, an effective solution to the problem would entail addressing all aspects that have been acknowledged in the map, and that there are no areas
which can be worked on in isolation. This is, however, a small map and were we to elaborate it further we might well find clusters indicative of disaggregation of the problem.

**Action:** (cluster analysis)

1. Go to the Analysis menu, Cluster options item. You should not need to change any of these options but check that the mode is set to “direct – all directions”. Check that the seed set option reads “none”.
2. Click OK to close this dialog.
3. Select the Analysis menu, Cluster item. A dialog will appear which tells you what the analysis does and that the results will be placed into sets. Click OK.
4. When the analysis is complete a dialog will appear to tell you that the analysis is finished and also the start of the set names that the results have been placed into. Click OK.
5. Using the command line, type “LS”.
6. You will now see that several sets have been created which are called cluster1, cluster2 and so on.
7. To view the contents of the clusters you can either map them or list them. To map the contents of a set type the command “map <set_name>”, substituting the name of the set in which you are interested. To list the contents of a set type “L <set_name>”. So to see cluster1, type “map cluster1” or “L cluster1”.

Clustering is very useful because it provides a breakdown of the model and becomes important in helping to manipulate information in large models.

**Complexity of linking**

If you are working with a small map, which can be adequately displayed on the screen or printed out successfully on a single page, then it is usually possible to judge by eye which concepts are the “busiest” and as such likely to represent a key part of the discussion. With larger maps this becomes more difficult. You may not be able to display the whole map on the screen and you may not want to work with multiple sheets of print out (although obviously this can be done). There are tools in Decision Explorer which help you to find, very quickly, the concepts that are most highly elaborated and which have a significant influence on the model as a whole. The “domain” command gives you an indication of the complexity of linking around concepts. The “central” command gives you an indication of the influence of a concept in the wider context of the model. As such these two analysis routines give you an initial indication of the importance of the different concepts in the model. It must be stressed that the analysis results should be considered as giving a starting point for discussion rather than definitive answers! The idea is that the results of the analysis will be debated and the substance of the model adjusted accordingly.

The rationale behind domain analysis is that people tend to talk a lot about what they see as important, or key issues, and so certain concepts characterising these “key issues” will be highly elaborated (a lot of concepts linking into and out of them). Highly elaborated concepts will have a high domain score.

Central analysis is, in a way, complementary to domain analysis. Central analysis looks beyond the immediate environment (links) around a concept and examines the complexity of links at a number of levels away from the centre. Picture the ripples spreading out from a
central point around a pebble dropped into a pond. The pebble is the central concept and the ripples are the levels at which concepts are given a weighted value. The combined weighting leads to an overall centrality score. The higher the score the more influence the concept has within the model as a whole. A high scoring concept has a complex network of concepts supporting it, and/or a complex network of concepts stemming from it. The topmost central concept may not in itself be top of the domain analysis results, likewise for lower scoring concepts. This is why central analysis is complementary to the domain analysis.

**Action:**

1. Using the command line type “domt 20” and press \[I\]. This asks Decision Explorer to perform a domain analysis looking for the top 20 rated concepts in the model and to look at both inward and outward links around concepts. You will now have a listing of the domain results displayed. (Other commands include “domi” (domain ins) and “domo” (domain outs) which consider only inward and outward links respectively).

2. Switch to another view and type “cent 20” and press \[I\]. This asks Decision Explorer to perform a central analysis, to 3 levels (which is the default), again showing the top 20 concepts. After a little processing time Decision Explorer will display a list of the central results.

3. Now have a look at the top few concepts in the domain listing and compare them with the top few concepts in the central listing. Are they similar? If this was your own data would it make sense to you for these concepts to be identified as key issues? If not you would go back to the model and find the concepts that you think are key and explore and elaborate them further.

**Analysing a hierarchical model**

Two of the analytical tools in Decision Explorer (“hieset” and “potent”) work in their most meaningful way for hierarchically structured models. These are maps where the “layers” of ideas move from the most general at the top (representative of aspirational concepts and which in a strategy or decision making model might be called “goals”), to the most specific at the bottom. The principle is that you may have many possible starting points – options that you might work on at the bottom (the start of a line of a line of argument or chain of events) and these lead to something bigger, which in turn leads to something bigger and so on. Until at the top of the model (the end of the lines of argument/ reasoning) you have broad statements, like “create a better environment for everyone”, “complete a wonderful project”, “meet our development targets”.

The logic behind the hierarchy is that people talk about issues generally with a view to making a situation better or ‘less bad’. These are things which we would like to achieve (‘goals’). We can all identify aspects of a situation which will satisfy us (or not) or where we would prefer one outcome instead of another. The bottom layers represent what we believe to be the causes of the situation and, perhaps, what might be improved or changed in some other way. The hierarchical structure for such a model is illustrated below. Goals/objectives are in the top layers of the hierarchy, strategies or key issues are in the middle, and options/assertions/facts are at the bottom. The labels that you attach to the ideas at each of the different levels of the model would change depending on the purpose of the model.
**Goals/most desired outcomes**

**Strategies/key issues** (found by looking for complexity)

**Options, assertions, supporting facts, from which actions are identified**

**Hierarchical sets (“hiesets”)**

**most potent options**

---

**A typical “decision” model structure**

Based on the work of C Eden and F Akermann

---

**Action:** (identifying hierarchical sets and “potent” concepts).

1. Type the command “hieset goals” and press enter. This performs a hierarchical set analysis, with the members of the set named “goals” as the seed set. The analysis will look at each member of the set goals (styles are implicit sets in Decision Explorer models) and collect together the concepts that support them. So, for each member of the set the result will be a listing of the concepts which support it (the subordinates of the concept). Think of the results of this analysis as a group of teardrops. Each teardrop contains a key concept and everything “underneath” it, which supports it (shown as the dotted triangles in the diagram above).

2. Type the command “LS”. You will see that there are now a number of sets called hieset1, hieset2, etc. If you want to you can map the contents of these sets.

3. Type the command “potent” and press enter. What you are doing now is looking for concepts that appear in a number of different hiesets. These are referred to as “potent concepts” because they contribute to a number of different key concepts higher up the model (those in the small, shaded triangle in the diagram above). The result of this analysis is a list of concepts which have had the style potent attributed to them, so that they can be easily identified when shown on a map display. You have to set up and attribute the style “potent” yourself but we have done it for you in this example.

---

**Hints and tips**

**Changing the substance of a model or changing the contents of a view**

Talking about chains of argument or lines of reasoning makes thinking and reasoning all sound rather “linear” but in fact arguments are rarely presented in a linear fashion. It is the process of breaking the argument down and reassembling it in a form of graphical representation that makes the linkages between the different parts of the argument explicit and therefore open to question. You will find that as you build up a model it is a network of interwoven supporting and contradictory ideas.

The concept text and the links between concepts form the substance of the model. Edit a concept and you change the substance of the model, edit a link and you also change the substance of the model.
The views which can be created (and you can create up to 32 views in a single model when using the full version of Decision Explorer) are simply separate sheets of paper, or screens, onto which you can project different parts of the model, in any combination that you choose.

Each view has two modes, a map display mode and a text display mode (the two sides of the piece of paper). A single concept can be displayed in multiple views. So, jumping forward a little, imagine that you have already entered 20 concepts. You have linked these concepts to illustrate the structure of your thinking. On view 1 you have mapped concepts 1 to 5. You have also decided to map the same concepts on view 2. If all that you do is to change the location of a concept on a view, say by moving concept 1 from the top left, to the bottom right of the map display area in view 1, then it will only change on that view. You are not affecting the substance of the model, only the layout or presentation of a part of the model. View 2 will remain unchanged.

If, however, you decide to edit the text of concept 1, in view 1, then you are changing the substance of the model and it will change on every view that it is currently displayed on.

Similarly if you decide to delete the link between concepts 1 and 2. Whichever view you do this in, it will be changed throughout the model, you have changed the substance of the model.

Think of the substance or body of the model as a network of ideas, within the core of the program. Perhaps you might imagine or picture a 3-dimensional molecular model when you think of this. The views are where you do your working; you add to and subtract from the substance of the model, but you can also draw out whichever features you want, without affecting the substance of the model.

To display the same concepts on another view, use the “map” command (or bring the layout). You do not need to ‘copy and paste’ concepts. You can present whatever you want on the views, they are where you chart the progress of your exploration of the model. This provides you with great power and flexibility.

**Display scales**

So that all of the concepts that you have entered or want to display can be seen, you can change the map display scale. Decision Explorer automatically opens a new model in the normal size display scale. Your model views will frequently expand to have more than 20 or so concepts, so there are four view scale options – normal size, half size, fit to window and select zoom. Normal size display means that the concept text is large and easy to read, but it also means that, using something like an Arial 12pt font for the concept text, you can only get about 20 concepts on the map display area. What you have is potentially a very large piece of paper and with the normal size display scale you are only seeing a part of it. It is a bit like having a poster sized sheet of paper and you are only looking at an area the size of a page from a book. Initially you may be happy working with the normal size display but as you become more experienced you will probably want to switch to the fit to window or scaled mode. Note that the screen will automatically refresh more often in ‘fit to window’ mode. Do not forget though that models will typically grow to have over 100 concepts, and that the views are a means of viewing sub-sections of the model.

**Refreshing the map display**

In Windows® applications the key is often used to refresh the display. You might, for example, have used it as a means of refreshing a file listing when exploring disk files.
Decision Explorer is just the same and the key is used to refresh the display. Sometimes when you move a concept around the map display you may find that there are fragments of the previous display left. This happens particularly when only part of the map display has been refreshed. Decision Explorer optimises the speed of redrawing by only refreshing key parts of the display, so it may look untidy but this is easily resolved by pressing the key.

**Link types**

There are various link types available in Decision Explorer. In this tutorial we have only used causal links. But you can devise your own link styles, to convey your own meaning.

- Causal links are the default type and these are read as “leads to”, “may lead to”, “supports” and so on.
- Temporal links are used to convey a time-related relationship e.g. concept 1 must happen before concept 2. They are displayed as an arrow link annotated with a “T”.
- Connotative links are used to show a connection, an associative or connotative relationship. These are displayed as a straight line, without arrowheads.

**The difference between the map and the bring commands**

If you type the command “Map 1” which will map concept 1 and its surrounding context, Decision Explorer will completely replace whatever you had previously on the map view that you are using. If you type “Bring 1” then Decision Explorer will simply bring (or “add”) concept 1 to the current map display.

**Concluding remarks**

We hope that now you have got a feel for how you might use Decision Explorer. There are approximately 40 analysis commands in the software and you have just been introduced to a few of them. As you become more familiar with Decision Explorer and you become an expert user you will find your own way of using the tools which it provides. What you may not have yet developed is a sense of the fluidity and the flexibility that Decision Explorer gives you when working with qualitative information, that comes with practise. The whole point of the software is that it lets you build models and then draw out from them whatever characteristics are important to you. This is done through adding meaning with the use of sets and styles for categorising data, and analysis for helping with the identification of key features in the model. The views should be treated as note pads or “doodle pads” on which you can display whatever you want. Display what you want, overwrite it as you carry on working to build up the model. The model is in the “body” of the software, the views are “windows” on to the body of the model. Do not get tied to using one view for everything.
Things to remember …

1. The substance of the model – the contents of the concepts (the text) and links that show the relationship between the concepts.

2. The views – your working spaces, where you can alter the substance of the model, but where you can also draw out and display any of the characteristics of the model that you choose.

3. The display scale – a means of changing the “paper size” you can see on the screen.

4. Use $F5$, the quick and easy way to refresh a fragmented display.

Feedback please

We would welcome your comments and feedback on this tutorial, on how useful you found it and how it might be improved.

Please email your comments to tutor@banxia.com. Thank you.